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RZ/T2M Group 
GPT Phase Count Sample Program (Z Phase support) 

Introduction 
This application note uses the general purpose PWM timer (GPT) phase counting mode feature of the RZ/T2 
M. 

This is a sample program that counts the number of pulses of a two-phase encoder (A phase, B phase) 
using the phase counting mode (phase counting mode 1) function. 

The main functions of the GPT Phase Count Mode (GPT Phase Count) sample program are shown below. 

1. Command input from the terminal acquires the count value of phase A and B pulses of the 3-phase 
encoder pulse number and resets the count value  

2. After the pulse of phase Z is acquired, the pulse counts of phase A and B are cleared.  

Target Device 
RZ/T2M Group 

 

When applying the sample program covered in this application note to another microcomputer, modify the 
program according to the specifications for the target microcomputer and conduct an extensive evaluation of 
the modified program. 
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1. Specifications 
Table 1-1 lists the peripheral functions to be used and their applications, Table 1-1 shows the operating 
environment. 

 

Table 1-1 Peripheral Functions and Applications 

 

Peripheral Function Application 

Serial communication 
interface (SCI) 

Used for setting instructions from the terminal. (Get or Reset 
instructions) 

General PWM Timer (GPT) Phase counting mode 1.  

The GTETRGA pin is used for Z-phase. 
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1.1 RZ/T2M operating environment 

Figure 1-1 Operating Environment (RZ/T2M) 
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1.1.1 Switch Setting 
■SW4 

1 2 3 4 5 6 7 8 

ON OFF ON ON OFF OFF OFF OFF 

 

■SW5 

1 2 3 4 5 6 7 8 9 10 

OFF OFF OFF ON OFF OFF OFF OFF ON OFF 

 

■SW6 

1 2 3 4 5 6 7 8 9 10 

OFF OFF OFF OFF OFF OFF OFF OFF OFF OFF 

 
 
1.1.2 Jumper Setting 

Table 1-2 Renesas Starter Kit+ for RZ/T2M jumper setting 

No Jumper number Setting 

1 CN17 Jumper 2-3 short 

2 J9 Jumper 1-2 short (When using JTAG) 

Jumper 1-2 open (When using J-Link OB) 

 

Function Connector Pin Signal Condition 

SCI CN16 TXD0(P16_5) 

RXD0(P16_6) 

UART_USB_TX 

UART_USB_RX 

USB on Renesas Starter Kit+ 
for RZ/T2M 

GPT JA2-A-10 

JA2-A-14 

JA2-A-24 

GTIOC1A(P17_6) 

GTIOC1B(P18_1) 

GTETRGA(P17_3) 

SCK3 

M1_UN 

ENCIF5 

Pin header on  Renesas 
Starter Kit+ for RZ/T2M 
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2. Operating Environment 
The sample program covered in this application note is for the environment below. 
 

Table 2-1 Operating Environment 
Item Description 

Board Renesas Starter Kit+ for RZ/T2M 

MPU RZ/T2M Group(R9A07G075M24GBG) 
Encoder(Motor) MB057GA140 
Conversion board RS-485 board 
Operating frequency CPU Core0：800MHz(ArmⓇ CortexⓇ-R52) 
Operating voltage 3.3V/1.8V/1.1V 
Integrated development environment Manufactured by IAR Systems 

Embedded WorkbenchⓇ for Arm Version 9.50.1 
Manufactured by RENESAS 
e2 studio 2024-01.1 (24.1.1) (R20240125-1623) 

Emulator Manufactured by IAR Systems 
I-jet 
Manufactured by SEGGER 
J-Link Base Ver.11.0 

Flexible Software Package (FSP) Version 2.0.0 
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3. Peripheral Functions 
The basics of the operating modes, Serial communication interface (SCI), General PWM Timer (GPT), and 
general I/O ports are described in the RZ/T2M Group User's Manual. 
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4. Hardware 

4.1 Hardware Configuration 
The hardware configuration is shown below. 

 

 

Figure 4-1 Hardware Configuration (RZ/T2M) 
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4.2 Pins 
The following table shows the pins and functions. 

 

Table 4-1 Pins and Functions (RZ/T2M) 
Pin name I/O Function 

TXD0(P16_5) Output Send data to terminal 

RXD0(P16_6) Input Receive data from terminal 

SCK3 (P17_6) Input 3-phase encoder Phase A signal 

M1_UN (P18_1) Input 3-phase encoder Phase B signal 

ENCIF(P17_3) Input 3-phase encoder Phase Z signal 
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5. Software 

5.1 Operation Outline 
This software uses serial communication interface (SCI) asynchronous communication to communicate with 
the host PC via COM port of RS-232 interface, and changes the bit mode by changing the program.  

Do one of the following with a command from the terminal software on the host PC. 

・  When you enter the "g" command, the count value is obtained. (When the pulse of phase Z is acquired,  

the count value is set to 0.)  

・  When you enter the "r" command, the count value is reset to 0. 

 

5.2 System Block Diagram 
Figure 5-1 shows the software configuration of this sample program. 

 

 

Application 

RZ/T2M 

Device Driver 

GPT Phase Count SCI 

PC(Terminal software) 

Figure 5-1 Software Configuration 
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5.3 Application 
5.3.1 Constants 
Table 5-1 shows the Constants  

Table 5-1 Constants 
Constant Name Setting Value Description 

CHARACTER_LENGTH_BYTE 20 Maximum data length of character string (unit: Byte) 
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5.3.2 Main function 
Figure 5-2 shown flowchart of the main function flowchart 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5-2 FLOWCHART (Initialize, Mode select) 
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5.3.3 Functions List 
Table 5-2 shows the functions. 

 
Table 5-2 Function list 

Layer / Block Function Name Chapter 

Application hal_entry () 5.3.3.1 

initialize () 5.3.3.2 

sci_uart_callback () 5.3.3.3 

handle_error () 5.3.3.4 
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5.3.3.1 hal_entry 
hal_entry 

Synopsis Master side main routine of the sample software 
Header hal_data.h 

Declaration void hal_entry(void) 
Description This is the master side main routine of the sample software. 
Arguments void none 

Return values - none 
 

 

5.3.3.2 initialize 
initialize 

Synopsis Initialize 
Header - 

Declaration static void initialize(void) 
Description Initialize for the following processes. 

 ・SCI_UART 
 ・SCI_UART_Baud 
 ・GPT Phase Count 

Arguments void none 
Return values - none 

 

 

5.3.3.3 sci_uart_callback 
sci_uart_callback 

Synopsis Callback function for sci_uart instruction 
Header - 

Declaration void sci_uart_callback(uart_callback_args_t* p_args) 
Description Receive the callback of the sci_uart instruction and process the events in the received 

callback. 
Arguments uart_callback_args_t* p_args A pointer to the Arguments information 

Return values - none 
 

 

5.3.3.4 handle_error 
handle_error 

Synopsis Error processing 
Header - 

Declaration static void handle_error(fsp_err_t err) 
Description Performs processing when an error occurs in processing using the FSP driver. 
Arguments fsp_err_t err fsp error content 

Return values - none 
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5.4 FSP driver functions 
5.4.1 SCI module functions 
Table 5-3 lists the functions to be used.  

Please refer to "RZ/T2M Flexible Software Package Documentation" for the function details. 

 

Table 5-3 Functions 
Function Description 

R_SCI_UART_Open SCI_UART open function 

R_SCI_UART_Close SCI_UART close function 

R_SCI_UART_Read Read from UART device 

R_SCI_UART_Write Write to UART device 

R_SCI_UART_CallbackSet User callback function 

R_SCI_UART_BaudSet Update SCI_UART baud rate 

R_SCI_UART_InfoGet Provides driver information 

R_SCI_UART_Abort Provides an API to abort an in-progress transfer 

R_SCI_UART_BaudCalculate Calculate the set value of the baud rate register 

R_SCI_UART_VersionGet Get the API version number 

 

5.4.2 GPT module functions 
Table 5-4 lists the functions to be used  

Please refer to "RZ/T2M Flexible Software Package Documentation" for the function details. 

 

Table 5-4 Functions 
Function Description 

R_GPT_Open GPT open function 

R_GPT_Stop Stop the GPT timer 

R_GPT_Start Start the GPT timer 

R_GPT_Reset Reset the GPT timer 

R_GPT_Enable Enables external event triggers to start, stop, clear or capture GPT 
counters 

R_GPT_Disable Disable external event triggers to start, stop, clear or capture counters 
in GPT 

R_GPT_PeriodSet Set the GPT period 

R_GPT_DutyCycleSet Sets the duty cycle value for the GPT 

R_GPT_InfoGet Gets information about the GPT clock, GTPR register, etc. 

R_GPT_StatusGet Gets the GPT timer counter value, etc. 

R_GPT_CounterSet Sets the GPT timer counter value 

R_GPT_OutputEnable Enables GPT output 

R_GPT_OutputDisable Disables GPT output 

R_GPT_AdcTriggerSet Set the A/D conversion start request timing register 



RZ/T2M Group  GPT Phase Count Sample Program (Z Phase support) 

R01AN7289EJ0110  Rev.1.10  Page 16 of 27 
Jun. 26, 2024  

R_GPT_CallbackSet User callback function 

R_GPT_Close GPT close function 
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6. How the sample application works 

6.1 How the EWARM version works 
Build the sample program and load it into RAM using IAR Embedded Workbench. 

 

Note: Please install FSP Smart Configurator in advance. 

 

1. Open a sample project. 

 
Figure 6-1 Open sample project 

 

2. Open "RZ Smart Configurator". 

Note: Smart Configurator must be registered in advance in [Tools] – [Configure Tools…]. 

[Tools] – [Configure Tools…] select [New] and enter the following: 

Menu Text : RZ Smart Configurator 

Command : “ Describe the absolute path of rasc.exe installation ” 

Argument : --compiler IAR configuration.xml 

Initial Directory : $PROJ_DIR$ 

 

 
Figure 6-2 RZ Smart Configurator 
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3. Click "Generate Project Content" to generate the code. 

 
Figure 6-3 Code generator 

 

4. Select "Rebuild All" from the "Project" menu to rebuild the project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6-4 Rebuild All 
 

5. After connecting the board and I-jet, select "Download and Debug" from the "Project" menu. 
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Figure 6-5 Download and Debug 

 

6. Select "Go" from the "Debug" menu to run the program. 

 
Figure 6-6 Run sample program 
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6.2 How the GCC version works 
Build the sample program and load it into RAM using Renesas Electronics e²studio. 

 

Note: Please install e²studio and apply FSP_Packs in advance. 

 

1. Import the sample project. After launching e2studio, select [File] → [Import] → [Existing Projects into 
Workspace]. Check [select archive file], select "RZ_T2_gpt_abz.zip" compressed folder → select 
[Finish]. 

 
 

 

2. Open "configuration.xml" of the project. 

 
 

Figure 6-7 Sample program import 

Figure 6-8 Configuration.xml 
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3. Click "Generate Project Content" to generate the code. 

 
 

 

4. Select your project and run the build. 

 
 

Figure 6-9 Code Generation 

Figure 6-10 Run build 
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5. After connecting the board and J-Link, start debugging by following the steps below. 

I. Select "Debug Configurations..." from the "Run" menu. 

 
 

II. In the [Renesas DBG Hardware Debugging] → [RZ_T2gpt.elf] item, press [Debug]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6-12 Run debug 

Figure 6-11 Debug Configurations 
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III. The following dialog will be displayed. Please switch to the debug screen. 

 
 

 

6. Debugging starts when you press the "Resume" button, and the program is interrupted at "hal_entry 
();" in main.c. Press the "Resume" button again to run the program. 

 

Figure 6-13 Switch debug screen 
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6.3 How the sample application works 
This sample program will communicate with a PC, so the preparations for its execution will be explained. 

 

1. Start the terminal software on the host PC and set the serial port as follows. 

      (When using COM3 with Tera Term) 

Figure 6-14 Serial port settings 

 

6.3.1 Operation 
When the sample program is executed and communication becomes possible, the sample program menu 

will be displayed on the terminal software. 
Note: Enter commands in lower case only 

Figure 6-15 Display of terminal software after running the sample program 
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6.3.1.1 Count Get operation 
In the state of Figure 6-15 input "g" and press Enter to read the GPT counter value. 

 
Figure 6-16 Count Get mode input example 

 

6.3.1.2 Count Reset operation 
In the state of Figure 6-15, input "r" and press Enter to clear the GPT counter value. 

 
Figure 6-17 Count Reset mode input example 
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7. About phase counting mode 
The operation of each mode of the phase counting mode is shown below. 

7.1 Phase counting mode 1 

 
 Figure 7-1 Phase count mode 1 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 

products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a 

system-evaluation test for the given product. 
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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 
of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 
that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 
specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.  
(Rev.5.0-1  October 2020)  

Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-to-date 
version of a document, or your nearest sales office, please visit: 
www.renesas.com/contact/. 

Trademarks   
Renesas and the Renesas logo are trademarks of Renesas Electronics 
Corporation. All trademarks and registered trademarks are the property 
of their respective owners. 
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